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Instruction Sheet Learning Guide #1

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:
e |dentifying Hardware components in terms of device type and
functions

e The interaction of components in terms of the flow of data

This guide will also assist you to attain the learning outcome stated in the cover page.
Specifically, upon completion of this Learning Guide, you will be able to:
e |dentify Hardware components in terms of device type and
functions

e Identify the interaction of components in terms of the flow of data

Learning Instructions:
Read the specific objectives of this Learning Guide.
Follow the instructions described below.
Utilize properly each information sheets

Accomplish the given “Self-checks.

a r w N oe

If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation
sheet.
6. Do the “LAP test” (if you are ready).
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Information Sheet-1

Identifying Hardware components in terms of device type and

functions

1. Computer

A computer is an electronic device, operating under the control of instructions stored in

its own memory that can accept data (input), process the data according to specified

rules, produce information (output), and store the information for future use.

2. Types of Computers

Computers are classified by their data processing method as Analog and Digital.

A. Analog Computers — Are a mechanical device, which is used to compute

calculations physically by the movement or rotation of movable party,

physically.

B. Digital Computers — is an electronic device, which is used to perform

complex and cumbersome operations.

-Based on their processing speed, power, cost and size computers can be

categorized in to four types.

1.
2.
3.
4.

Microcomputers
Minicomputers
Main frame computers

Supercomputers

1. Microcomputers (personal computer) — These types of computers are

relatively small in size and cheaper in cost.

-Microcomputers come in a Varity of sizes and shapes for a Varity of purposes.

Basically they can be grouped in to three. These are Laptop, Palmtop and

Desktop_computers.

The size of Desktop>Laptop>Palmtop.

2. Minicomputer — Minicomputers are Mid-range computers. Those are large and

more powerful than most microcomputers but are smaller and less powerful than

mainframe computer systems.
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3. Mainframe Computers — Are large, powerful computers that are physically
larger than micros and minis computers usually have processor with faster
instruction processing speed. For example, they may be able to process from 10
to 200 million instructions per second (MIPS).

-This type of computers is less expensive than supercomputer & slow and
smaller than the supper computer.

4. Monster (Supper) Computers — The term supper computer has been coined to

describe a category of extremely powerful and most expensive computer

designed for high speed processing.

3. Functionalities of a computer

Any digital computer carries out five functions in gross terms:

.~ Takes data as input.
_ Stores the data/instructions in its memory and use them when required.
_ Processes the data and converts it into useful information.
" Generates the output
Controls all the above four steps.

Processing

Data ——

Information

Computer Components

Any kind of computers consists of HARDWARE AND SOFTWARE.

Hardware:

Computer hardware is the collection of physical elements that constitutes a computer
system. Computer hardware refers to the physical parts or components of a computer
such as the monitor, mouse, keyboard, computer data storage, hard drive disk
(HDD), system unit (graphic cards, sound cards, memory, motherboard and chips),

etc. all of which are physical objects that can be touched.
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4. Input Devices
Input device is any peripheral (piece of computer hardware equipment to provide data
and control signals to an information processing system such as a computer or other

information appliance.
Input device Translate data from that humans understand to one that the computer can

work with. Most common are keyboard and mouse.
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Examples of Manual Input Devices

Keyboard

g

Numeric Keypad

Pointing Device

o

Remote Control

Touch Screen

Scanner

>

Graphics Tablet

Microphone

Light Pens

Example of Input Devices:-

1. Keyboard

2. Mouse (pointing device)

3. Microphone

4. Touch screen

5. Scanner

6. Webcam

7. Touchpads

8. MIDI keyboard

9

10.Graphies Tablets

11.Cameras

12.Pen Input

13.Video Capture Hardware

14.Microphone

15.Trackballs

16.Barcode reader

17.Digital camera

18.Joystick

19.Gamepad

20.Electronic Whiteboard

21.
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Self check 1

Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page:

PART | Write the correct answer if itis True say True ifitis False

say False

1. Input device is translate data from that humans understand to one that the computer

can work with.

2. keyboard and mouse are not most common Input devices.

3. Computer hardware is the collection of physical elements that constitutes a computer

system.

4. Computers are classified by their data processing method as Analog and Digital.
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5. A computer is not an electronic device.

PART Il Multiple Choices

1. A machine that can receive and store information and change or process it.
A. CD/DVD
B. Computer
C. Flop disk
D. All
1. Which of the following is not true about the types of computer
A. Mainframe computers are large-sized, powerful multi-user computers
B. Mini micro computers Are small and less powerful than most micro
computer
C. . Mini-computers are mid-sized multi-processing computers.
D. Aand B

2. Which one of the following computer is extremely powerful and most expensive
computer designed for high speed processing.
A. Monster (Supper) Computers
B. Micro computer
C. Minicomputer
D. Personal computer
2. is the center for your computer processing activity.
A. CPU
B. Mouse
C. Key board
D. Microphones
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Information Sheet-2 The interaction of components in terms of the flow of data

1. Central Processing Unit (CPU)A CPU is brain of a computer. It is responsible
for all functions and processes.
Regarding computing power, the CPU is the most important element of a computer
system.
a. Primary Memory:-

1. RAM: Random Access Memory (RAM) is a memory scheme within the computer
system responsible for storing data on a temporary basis, so that it can be promptly
accessed by the processor as and when needed. It is volatile in nature, which means
that data will be erased once supply to the storage device is turned off. RAM stores data
randomly and the processor accesses these data randomly from the RAM storage.
RAM is considered "random access" because you can access any memory cell directly
if you know the row and column that intersect at that cell.

2. ROM (Read Only Memory): ROM is a permanent form of storage. ROM stays
active regardless of whether power supply to it is turned on or off. ROM devices do not
allow data stored on them to be modified.

b. Secondary Memory:-
Stores data and programs permanently: it’s retained after the power is turned off

1. Hard drive (HD): A hard disk is part of a unit, often called a "disk drive,” "hard
drive," or "hard disk drive," that store and provides relatively quick access to large
amounts of data on an
electromagnetically charged surface or set of surfaces.

2. Optical Disk: an optical disc drive (ODD) is a disk drive that uses laser light as
part of the process of reading or writing data to or from optical discs. Some drives can
only read from discs, but recent drives are commonly both readers and recorders, also
called burners or writers. Compact discs, DVDs, and Blu-ray discs are common types of

optical media which can be read and recorded by such drives. Optical drive is the
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generic name; drives are usually described as "CD" "DVD", or "Bluray”, followed by

"drive", "writer", etc. There are three main types of optical media: CD, DVD, and Blu-ray
disc. CDs can store up to 700 megabytes (MB) of data and DVDs can store up to 8.4
GB of data. Blu-ray discs, which are the newest type of optical media, can store up to
50 GB of data. This storage capacity is a clear advantage over the floppy disk storage

media (a magnetic media), which only has a capacity of 1.44 MB.
2. Desktop

The desktop is a work space that appears on the computer screen after you start a
computer. It is an area where you can organize your computer work. The desktop can

contain: icons, taskbar, start button, and mouse pointer.

The Windows XP Desktop

{c) helpwithpos.cam

Cesktop

Taskhbar Clock

Start button

2.1. Elements of a desktop

Icons: are small pictures that represent a program or applications, files, folders,
other objects.
E.g.
e The My computer icon represents a program you use to organize the files in the
computer.

The Recycle Bin icon represents a storage area for deleted files.

e Folder icons are usually yellow in colour and they are organizers for files

and other folders. E.g. My Document folder.

e File icons: represent files. They look different because the type of icons

lepends o the a
Page 10 of BZP " Federal T\F/JIE

lication

T Agency
Author/Copyright

which they are created or the a
Tvet Program title : Basic Metal Work
Level 1

[

plication (or
Version -1
October 2019




S
program) they represent. This in turn has a significant role to help user to
easily identify file types.

o Taskbar: the bar usually located at the bottom of the desktop that organize the

start button, opened windows, and the system date and time indicator.

start button window tabs

4 start i Microsoft word - ... 7 Microsoft Excel - Book I S 919 PM

system tray

o Start button: used to display a menu from which you can start programs, open
documents, change system settings, get help, find files and folders, run
applications and turn off the computer.

o Mouse pointer: an input device that help you to move, copy, select, deselect

objects on the desktop and other windows.
3. MOUSE

Mouse is a small hand—held input device that you move around on your desk, usually
on mouse pad. When you roll the mouse across your desk, a pointer (an arrow shape)
moves on the screen.
A mouse makes it easy for you to point at object on the screen- an operation that you
cannot do easily with a keyboard. Using a mouse, you can quickly select different
screen objects, such as icons or menus.
A typical mouse has two buttons (left and right) for issuing commands. Some mice
have three buttons in which the middle button has various functions, depending on the
program being used.
e The left mouse button (primary button) is the one used most frequently. Most
commands are issued with the button.
e The right mouse button (secondary button) is used to display a short cut menu
(pop-up menu) which contains list of actions and options that can be applied on

the selected item.
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Self check 2 Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in
the next page:

Write the correct answer if itis True say True if it is False say False

1. CPU is brain of a computer It is responsible for all functions and processes
Regarding computing power.

2. (RAM) is a memory scheme within the computer system responsible for storing data
on a temporary basis,

3. desktop is a work space that is not appears on the computer screen after you start a
computer.

4. Mouse is a small hand—held input device that you move around on your desk.

5. A mouse does not makes easy for you to point at object on the screen- an operation
that you cannot do easily with a keyboard.

Part Il matching

Column A column B

1 CD A. Input Device

2 Key Board B. Functional key

3 F1,F2F12.. C. optical storage

4  Mouse D. Controlling the overall operation of system

5  Controlling unit E. perform task like calculation

6___ Arithmetic and logic unit  F output device

7 RAM G. Permanent memory

8 ROM H. Temporary work space

9 Printer I. move the insertion point around the screen
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Information Sheet-3 Understand operation of the system and application

software

1. Computer Software
- Software is the general term for set of instruction that controls a computer or it is a
series of instruction that tell the hardware what to do. It include all set of information
processing instruction.
Computer software is divided in to two major categories.
e System Software
e Application Software
1.1. System software — Consists of instructions or programs that are used to manage
the hardware resources of a computer and perform required information processing
tasks.
- It provides the interface between the hardware and the user. Interface is the means
by which a person interacts with a computer.

- System software includes; Operating system, system support and system

development software.

Operating system software — is a set of programs that control and
supervises the overall performance of the computer. E.g. Ms-DOS
and MS-Window

System support software — Provide system utilities and other operating
services. E.g. Disk format programs.

System development — It includes the computer programming translators that
are used to convert written programs to machine language for execution.

1.2. Application software — Consists of programs that in conjunction with system
software instruct the computer to perform specific information processing activities.
E.g. MS-Word, MS-Excel, MS-Access------------

2. Types Of Operating System
1. Single-User, Single-tasking — Used to stand alone computer. It can only enable

the user to perform one task at a time and can serve only one user at a time
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2. Single-User, Multi-tasking — an operating system, which can serve only one user
at a time but enable the user to concurrently run multiple programs or performs
multiple tasks.
3. Multi-user, Multi-tasking — an operating system, which serve many user at a time

to perform different tasks.

Self check 1 Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page:_Write the correct answer if it is True say True if it is False say

False
1. Software is the general term for set of instruction that controls a computer.
2. Software is not a series of instruction that tell the hardware what to do.
3. System software is provides the interface between the hardware and the user.
4

. System support software is provide system utilities and other operating services.
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BASIC METAL WORKS

Level-|

Learning Guide-54

Unit of Competence: Operate Personal Computer

Module Title: Operating Personal Computer
LG Code: IND BMW1 M16 LO2-LG-54
TTLM Code: IND BMW1 M16 TTLM 1019v1

LO2: Understand operation of the system and

application software
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Instruction Sheet Learning Guide #2

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:

e . ldentifying and describing System software

e . ldentifying and stating purpose of application software

e . Describing the interaction between system software and application software
This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

e System software is identified and described in terms of its purpose and operation
e Application software is identified and its purpose stated in terms of outputs

e The interaction between system software and application software is described

Learning Instructions:

1. Read the specific objectives of this Learning Guide.

2. Follow the instructions described below.

3. Utilize properly each information sheets

4. Accomplish the given “Self-checks.

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation
sheet.

6. Do the “LAP test” (if you are ready).
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Information Sheet-1 | System soft ware

1. Software

Software is a generic term for organized collections of computer data and instructions,
often broken into two major categories: system software that provides the basic
nontask- specific functions of the computer, and application software which is used by
users to accomplish specific tasks.

Software Types

A. System software is responsible for controlling, integrating, and managing the
individual hardware components of a computer system so that other software and the
users of the system see it as a functional unit without having to be concerned with the
low-level details such as transferring data from memory to disk, or rendering text onto a
display. Generally, system software consists of an operating system and some
fundamental utilities such as disk formatters, file managers, display managers, text
editors, user authentication (login) and management tools, and networking and device
control software.

B. Application software is used to accomplish specific tasks other than just running
the computer system. Application software may consist of a single program, such as an
image viewer; a small collection of programs (often called a software package) that
work closely together to accomplish a task, such as a spreadsheet or text processing
system; a larger collection (often called a software suite) of related but independent
programs and packages that have a common user interface or shared data format, such
as Microsoft Office, which consists of closely integrated word processor, spreadsheet,
database, etc.; or a software system, such as a database management system, which is
a collection of fundamental programs that may provide some service to a variety of

other independent applications.
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Comparison Application Software and System Software

System Software Application Software

Computer software, or just software is a
general term primarily used for digitally stored | Application software, also known as an
data such as computer programs and other | application or an "app". is computer software
kinds of information read and written by | designed to help the user to perform specific
computers. App comes under computer | tasks.
software though it has a wide scope now.

Example: . . 1) Opera (Web Browser

atp 1) Microsoft Windows ) P ) ( ) , ) .
. 2) Microsoft Word (Word Processing)
2) Linux 3) Microsoft 1 (Spreadsl frwar
3) Unix 3) Microsoft Excel (Spreadsheet software)
. e 4) MySQL (Database Software)
4) Mac OSX S N ) . o D w )
5) DOS 5) Microsoft PowerPoint (Pr esentation Software)
i 6) Adobe Photoshop (Graphics Software)
.( i = . T -. [ J h i -( ". 1 i h y

Interaction Generally, users do not interact with system Users 11}»33@. 1{1@1'16'[ v§1't_hl a.pphcanou software
S T o while doing different activities.
software as it works in the background.

Dependency: System software can run independently of the | Application software cannot run without the
application software. presence of the system software.

Self checkl Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page

these questions are multiple choices; in each case, find the most plausible answer

1. is used to accomplish specific tasks other than just running the
computer system.
A. Application software B. System software C. Software  D. None

2. software may consist of a single program, such as an image viewer;

A. Software B. Application software C. System software
3. a small collection of programs often called a

A . software suite B. software package C. Software  D. None
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Information Sheet-2

The interaction between system software and application

1. Storage measurements: The basic unit used in computer data storage is called a

bit (binary digit). Computers use these little bits, which are composed of ones and

zeros, to do things and talk to other computers. All your files, for instance, are kept in

the computer as binary files and translated into words and pictures by the software

(which is also ones and zeros). This two number system, is called a “binary number

system” since it has only two numbers in it. The decimal humber system in contrast has

ten unique digits, zero through nine.

Size example

Computer Storage units

Bit BIT Oorl
Kilobyte KB 1024 bytes
Megabyte MB 1024 kilobytes
Gigabyte GB 1024 megabytes
Terabyte B 1024 gigabytes

+ 1 bit - answer to an yes/no question

* 1 byte - a number from O to 255.

* 90 bytes: enough to store a typical line of text from a book.

» 4 KB: about one page of text.

« 120 KB: the text of a typical pocket book.
+ 3 MB - a three minute song (128k bitrate)

* 650-900 MB -

an CD-ROM

« 8-16 GB - size of a normal flash drive

1 GB -114 minutes of uncompressed CD-quality audio at 1.4 Mbit/s

2. Speed measurement: The speed of Central Processing Unit (CPU) is measured by

Hertz (Hz), Which represent a CPU cycle. The speed of CPU is known as Computer

Speed.

CPU SPEED MEASURES

1 hertz or Hz

1 cycle per second

1 MHz 1 mullion cycles per second or 1000 Hz
1 GHz 1 billion cycles per second or 1000 MHz
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3. Windows Overview

Windows is an operating system. An operating system is software that co-ordinates the
overall activities of a computer and control the way the computer work. As the operating
system, windows control all the basic functions of the computer. Windows serves as the
interface between you and the hardware and software that make up the computer
system.
Window is a rectangular framed region on the desktop that provides commands and
activities which enable you to easily manage, communicate and work with applications,
dialog boxes, etc.
4. switching on and Turning off /shutting down the computer

a. Switching on computer
You switch on the computer with a power switch on the front or side of the system unit.
If the monitor light doesn’t come on after about 3 seconds, i.e. after you turn on the
system units on-off switch, find and press the monitor’s on—off switch.
b. Turning off /shutting down the computer

e Click on start

e Click on Turn Off Computer

e The diagram below will be displayed and click on Turn Off button

Standby - This will put your computer into standby mode, basically it will power down

components like the monitor and hard drive to preserve energy.

Turn Off - Shuts down the PC, always use this option to turn off your PC.

Restart - this will restart the computer.
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Self check?2 Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page

these questions are multiple choices; in each case, find the most plausible

answer

1. The basic unit used in computer data storage is called a

A.Bit B. binary digit C.A&B D. None
2. is control all the basic functions of the computer
A. windows B. Bit C.A&B D. None

3. The Nspeed of Central Processing Unit is measured by Speed measurement
called.

A. Click on start B. Hertz (Hz) C. Turn Off D. A&B
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BASIC METAL WORKS

Level-|

Learning Guide-55

Unit of Competence: Operate Personal Computer

Module Title: Operating Personal Computer
LG Code: IND BMW1 M16 LO3-LG-55
TTLM Code: IND BMW1 M16 TTLM 1019v1

LO3:Perform basic operation and maintenance

procedures
Instruction Sheet Learning Guide #3
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This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

e connecting basic components of a PC system

Safety requirements during connecting PC components

Identifying Simple hardware faults

airing for and maintaining A PC system

powering up a PC system according to organisational requirements

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

connect basic components of a PC system

Safety requirements during connecting PC components

power up a PC system according to organisational requirements

Identify Simple hardware faults

correct or report Simple hardware faults

airing for and maintaining

Learning Instructions:

A PC system

1. Read the specific objectives of this Learning Guide.

2. Follow the instructions described below.

3. Utilize properly each information sheets

4. Accomplish the given “Self-checks.

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation

sheet.

6. Do the “LAP test” (if you are ready).

Information Sheet-1

Saving and Opening Files

Qa\/ing Eiles
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You create documents by using application programs like WordPad. The word file refers

to any document that is saved or will be saved onto a storage device like floppy disk or

hard disk for future use.

Most windows program provide two commands that let you save document — save and

save as commands.

Sove 5= @&
Savein: | () My Documen te ~v @ = -
~ (B Fax
<3 By rusic
My Recent My Pictures
Document ts
o
Desktop
My Documents
w3
My Computer
€@ rieneme -
=
My Network Save as type: Fiich Text Format (RTF) ~ Cance ]

e Click on save button on standard tool bar OR choose file —save or file —save

As from menu bar.

e Select the folder or drives from save In combo box where you want to save

document from the save as dialog box appeared.

e Type the file name in the file name text box, and

e Click on save button.

If you are saving the document for the first time save and save as commands are the

same. How ever, use the command:

- Save: to save a file for the first time and to update a saved file under the

same name and location

- Save As:

different location.

To open a Document

to save a file for the first time or under a new name and/ or to a

e Click on File — open command from menu bars OR click open button on

standard tool bar.
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Click on the look In combo button and select the drives or folder that

contains the file you need to open from the open dialog box appeared.

Select the file name you want to open

Click on open button OR Double click on the file name.

Look in:

I "J My Documents

Sl -5 @ X 0 F - ok

<
o
g
b=l

My Documents

5

=]
@
in
&
=1
o

1
T
&%

4 5

o
Iy Metwork
Places

|Z)Example of IS
= html
jMy Music
My Pictures
EMV videos
@My Webs
) Office
|2 Unzipped
E‘ﬂmarkllstnzaw.x\s
File narne: I j open |+

Files of bvpe: IA\I Microsaft Excel Files (*,xI%; *,xls; * %ty * htmy *.html; j

Cancel

2. Understanding File Management

e File management is organizing and keeping track of files and folders

e File —is a collection of computer data that has some common purpose.

e E.g. aletter you have typed, a picture you have drawn.

e Folder- is an electronic location in which you store groups of related files.

It is also possible to place folders inside of other folders.

e E.g. afolder to store all the files for an application program.

e Drive —is a physical place in which you store files and folders.

e E.g. afloppy disk, hard disk.

e File management can help you do the following:

o Create a new folder so you can reorganize information

o Examine and organize files and folders in a file hierarchy

o Copy, move, and rename files and folders

o Delete files and folders you no longer need and restore files you delete

accidentally

o Locate a file easily with the Search feature
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. Create shortcuts to files and folders

3. Creating new folder:

To create a new folder, select the location where you want to create the new
folder, and then name it meaningfully, so you can know its contents by reading
the name

Thus

— Navigate to the folder where the new folder will be stored

— Click File on the menu bar, point to New, then click Folder

— Type the folder name, then press [Enter]

4. Renaming file and folder:
e Navigate to the disk drive which contains the file or the folder you want to
rename.
e  Select the file or the folder
e Choose file menu and click Rename
e Type the new name and press ENTER key.
Or
¢ Right—click the file or the folder and click rename from the short cut (pop-up)
menu.
e Type the new name and press ENTER key.
5. Deleting a file or a folder using file menu:
e Navigate to the disk drive which contains the file or the folder you want to delete.
e Select the file or folder
e Choose the file menu and click delete
6. Customizing a Desktop
To change your desktop background
1. To open Display Properties, click Start, click Control Panel, and then double-
click Display, OR, Right click on free Desktop area then choose Properties.
2. On the Desktop tab, do one or more of the following:
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Click a picture in the Background list. In Position, click Center, Tile, or Stretch.

Click Browse to search for a background picture in other folders or on other drives.

You can use files with the following extensions: .bmp, .gif, .jpg, .dib, .png, .htm. In

Position, click Center, Tile, or Stretch.

Select a color from Desktop color. The color fills the space not used by a picture.

Click Apply button
Finally click on OK

Display Properties

Theme:
Windows XP

Themes | Desktop Screen Saver Appeatance = Seltings

A theme is a background plus a set of sounds. icons. and other elements
to help you personalize your computer with one click.

]3]

%) Coomre )

My Cusrent Theme
ndows XP

- 4 Active Window

-

(ZJ@@I

OK ] [ Cancel j

To set or change a screen saver

1. To open Display Properties, click Start, click Control Panel, and then double-

click Display, OR, Right click on free Desktop area then choose Properties.

2. On the Screen Saver tab, under Screen saver, click a screen saver in the list.

After you select a screen saver, it will automatically start when your computer is
idle for the number of minutes specified in Wait.

To clear the screen saver after it has started, move your mouse or press any key.
To view possible setting options for a particular screen saver, click Settings on
the Screen Saver tab.

Click Preview to see how the selected screen saver will appear on your monitor.

Move your mouse or press any key to end the preview
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To set or change a screen saver

3. To open Display Properties, click Start, click Control Panel, and then double-

click Display, OR, Right click on free Desktop area then choose Properties.

4. Onthe Screen Saver tab, under Screen saver, click a screen saver in the list.

After you select a screen saver, it will automatically start when your computer is
idle for the number of minutes specified in Wait.

To clear the screen saver after it has started, move your mouse or press any key.
To view possible setting options for a particular screen saver, click Settings on
the Screen Saver tab.

Click Preview to see how the selected screen saver will appear on your monitor.

Move your mouse or press any key to end the preview.

To set or change a screen saver

5. To open Display Properties, click Start, click Control Panel, and then double-

click Display, OR, Right click on free Desktop area then choose Properties.

6. On the Screen Saver tab, under Screen saver, click a screen saver in the list.

After you select a screen saver, it will automatically start when your computer is
idle for the number of minutes specified in Wait.

To clear the screen saver after it has started, move your mouse or press any key.
To view possible setting options for a particular screen saver, click Settings on
the Screen Saver tab.

Click Preview to see how the selected screen saver will appear on your monitor.

Move your mouse or press any key to end the preview.
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Self checkl Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page

PART | these questions are multiple choices: in each case, find the

most plausible answer

1. is use to see how the selected screen saver will appear on your monitor.

A . Click preview  B. clicksettings C .a&b D. None
2. To open Display Properties,
A. clickStart B.clickControlPanel, C. double-clickDisplay, D.all

3. IS select the location where you want to create the new folder,

A. To create a new folder B. click Control Panel, C. double-click Display, D.all
4. Saving file is
A. The process of storing a document on computer for further use
B. The process of writing a document from Random Access Memory (RAM) to

secondary storage devices like floppy disk
C. The processes of retrieving (accessing) back a document from hard disk to RAM.

D.All except C
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PART | Matc
Column A
1. _ Desktop
2. __ _lcon
3 Window
4  Title bar
5 Task bar
6 Floppy disk
7___ Hard disk d

hing

column B
A. where the operating system and application program are

kept

B. the least storage media
C. that appear at the top of the window
D. Horizontal bar at the very bottom of the desk top
E. Area on the screen
rive F. Back ground screen
G. small picture that appear on your desk top
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Information Sheet-2 Maintenance

the Hard Drive
A. Disk Cleanup

To keep a PC running smoothly, regular maintenance is critical. The Disk Cleanup Utility can
determine which files on your hard drive may no longer be needed and delete those files. In
addition to freeing up potentially significant amounts of hard drive space, using Disk Cleanup on

a regular basis can improve system performance.
The utility can be accessed in any of the following methods listed below.

* Click Start | All Programs | Accessories | System Tools | Disk Cleanup

* Click on Start and search for Disk Cleanup

Use the drop down menu to choosethe drive you want to clean.
NOTE:

The process of scanning your hard drives may take a few minutes

When the scan is complete you will be presented with a list of temporary folder and the
amountof space used by the each folder.

Select:

Temporary Internet Files
* Recycle Bin

» Temporary files

Click OK.
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=g Disk Cleanup is calculating how much space you will be
g abletofree on BOOTCAMP (C:). This may take afew
minutes to complete.

Calculating...

- T
Scanning: System emor memony dump files

| Cancel I

-

=, Disk Cleanup for BOOTCAMP {C3)

=)

Disk Cleanup

Files to delete:

ﬂ Downloaded Program Files 0 bytes

=) Temporary Intemet Files
[ ‘E Recycle Bin

] || Setup Log Files

[ || Temporary files

== fou can use Disk Cleanup to free up to 23.3 KB of disk
space on BOOTCAMP (C:).

0 bytes
0 bytes
253 KB
0 bytes

Description

Total amount of disk space you gain:

Downloaded Program Files are ActiveX controls and Java applets
downloaded automatically from the Intemet when vou view certain
pages. They are tempaorarity stored in the Downloaded Program

Files falder on your hard disk.

[ I@llﬁlﬂan up gystem files ]

How does Disk Cleanup wors?

0 bnvtes
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The process of deleting your cached files can take a few minutes
b. Disk Defragmenter

Disk Defragmenter is used to organize files on the hard drive and optimize free space,
improving the speed and performance of the computer. Some applications may fail outright if

the disk becomes too fragmented.

1. To run Disk Defragmenter, click on Start | All Programs | Accessories | System Tools |
Disk Defragmenter.

Hy Disk Defragmenter L = et S

»  Dick Defragmenter consolidates fragmented files on your computer's hard disk to improve system
@' performance. Tell me more about Disk Defragmenter.

Schedule:

Scheduled defragmentation is turned on ’ '5' Configure schedule...
Run at 1:00 AM every Sunday
Mext scheduled run: 11/13/2011 1:00 AM

Current status:

Disk Last Run Progress
&, BOOTCAMP (C:) 11/11/2011 10:06 AM (3% fragmented)

Only disks that can be defragmented are shown,
To best determine if your disks need defragmenting right now, you need to first analyze your disks.

[ ) Analyze disk ] [ Ay Defragment disk ]

Close

NOTE

You MUST have administrative rights in order to perform this process.

2. If your hard drive is partitioned (you have more than one drive), choose which drive you wish

to defragment. In most cases, you will select C.

3. Click on the Defragment disk button to begin the operation.
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4. When defragmenting begins it will always analyze the hard drive first and then start the

defragmentation process.

By Disk Defragmenter [ = ihJ

»  Disk Defragrmenter consolidates fragmented files on your computer's hard disk to improve system
+  performance. Tell me more about Disk Defragmenter.

Schedule:

Scheduled defragmentation is turned on [ # Configure schedule... l
Run at 1:00 AM every Sunday
Mext scheduled run: 11/13/2011 1:00 AM

Current status:

Disk Last Run Progress
i--_-{‘BOC]'I'UJ«IMI:' (C:) Running... Pass 2: 7% relocated

Only disks that can be defragmented are shown.
To best determine if your disks need defragmenting right now, you need to first analyze your disks.

[ % Stop operation l

|
Close

2. Maintaining the Battery

NOTE

Most laptop batteries will last at least four hours when fully charged. If not maintained,
however, the battery will require charging more frequently. Following are tips for
properly maintaining your battery for maximum performance.

Use the battery as your power source until the low battery warning emerges

Using your laptop with the AC adapter plugged into an electrical outlet will overcharge
the battery. Overcharging decreases the life of the battery. Eventually the battery will be
unable to hold a charge and will require a replacement.

Condition the battery for maximum performance

1. Discharge the battery — use the battery until the low battery warning emerges.
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2. Charge the battery — use the AC adapter until the battery is fully charged. Then

immediately disconnect the AC adapter from the notebook.

The procedure above insures both maximum performance and long life for the battery.

3. Introduction to Microsoft Word

Microsoft Word (MS-Word) is word processing software that runs on the windows

operating system, which enables you to create, edit, format, save and print document

for future retrieval.

Advantage of MS-Word over type-writer:

MS-Word is software that overlooks the work of typewriter.

MS-Word enables you see and adjust the print preview of your document that avoids

wastage of resources.
MS-Word enables you format and edit your documents as you wish
MS-Word enables you correct spelling and grammar errors

MS-Word enables you easily create various types of web pages

MS-Word enables you enter pictures, tables, symbols, and data from other sources

Using MS-Word you can exchange data with other software (e.g. MS-Excel, Ms-

Access, etc), create columns, mail merge, drawing, etc.

4.1. Starting MS-Word Program:

- Click the start button
- Move mouse pointer to Programs /All Programs menu
- Point to Microsoft office

- Point to Microsoft office Word 2003 and click on it.
4.1.1 The Screen Element of MS-Word
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File Edit Yiew Imsert Formak Tools  Table  Window  Help Type a question For belp (= [ X
BHSUERY | IBRC -~ QARG T = -0,
Marmal - TimesMewRoman - 12 - B 7 0O = H £ i

[
A
[c] L de ez ii3ecieae o5 SRS | % NewDocument v x
| Open a document
wword ¥P Book 1
Aiccess ¥P Book 1

word 97 day 1
Access 97 Day 3
[ More documents. ..
New
- [ Elank Document
o I @ BElank web Page
' A Blank E-mail Message

MNew from existing document
@j Choose document, .

New from template

] General Templates...
%I Templates on my Web Sites...

v ] Templates on Micrasaft, com

N fl £ Add Network Place. ..
- @ [2) Microsoft Word Help
= S (B & [Vl Show at startup
Daw [3 | auoshapes~ . W OO E 4 R E | &-Z-A-=E=28d4.
Page 1 Sec 1 11 ar 1" ln1  Col 1 REC TRK EXT OWR
fstart ||| 1] @ 53 || $untitied - paint |[Fpocument1 - Microsof... |4 8a% 8, 2azem
Title Bar - Indicates application and current document in
use
Menu Bar - General headings for accessing commands
Standard Toolbar - Quick access to basic features of Word
Formatting Toolbar - Quick access to change the look of text
Ruler - Indicates Margin, Tab and Indentation
settings. Can also be used to change these
settings.
Scroll Bars - Allows quick movement around document
Status Bar - Shows position of Insertion Point and
document status
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4.2. Creating and Closing Documents

A. Creating a New Document

A new document can be opened at any time within Word:
e Select File | New.
e The New dialog box will appear on the screen.
¢ In the New section click on Blank Document.

B. Closing a Document

To clear all text from the screen and begin working on a new document:

Select the File | Close command OR Click Close window button (x) on menu bar

below the close button.

If the document has not been previously given a file name, or if it has been modified in any way,

Word displays

Microsoft Word |

& Co wou want o save the changes to "Word %P Book 17

Mo | Zancel |

e Three options are given:

Yes displays the Save As dialog box if the document has

just been created or automatically saves the

document if it is being modified.

No clears the document from the active window.
Cancel returns to the document.
Exiting Word

The final step of every word session is to exit word. To exit word:

e Choose File=> Exit menu from menu bar OR click the applications close button on

title bar
4.3. Saving and Opening Word Documents

To save the work book

Author/Copyright Level 1
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. Click on File

. Clickon S

ave As /Save

. Type the file name in the file name box and

. Slick save

To Open Existing file

. Open MS-Excel and click on file

. Select the folder that contains your file from look in box

0
1
2. Click on open
3
4

. Select your file and

5. click on Open
4.4. Editing Word Documents

Editing is the process of inserting new items (text, drawing, pictures), removing

1
2
3. Select the location from Save In box where you want to save your file
4
5

unwanted items and/or modifying existing ones. One of the major advantages of word

processor over type writer is the case with which one can edit documents after creating

them.

4.5. Select text and graphics

Before performing any operation (copying, moving, formatting and the likes) on a

document, you must first select the text. You can select text and graphics by using the

mouse or the keyboard, including items that aren't next to each other. For example, you

can select a paragraph on page one and a sentence on page three.

Select text and graphics by using the mouse

e Any amount of text

Drag over the
e A word

Double-click t
e An entire docume

Edit-> Select
e A graphic

text.

he word.

nt

Click the graphic.
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4.6. Deleting text and graphics
You can delete one character at a time or delete a large block of text by selecting it first,
and the remaining text shifts over to fill the vacated space and line breaks adjust
automatically.
e To delete text character by character :
- Press Delete key if the insertion point is just before the text to be deleted
- Press Backspace key if the insertion point is just after the text to be
deleted
e To delete a block of text :
- Select the block and press Backspace or Delete key or Choose Edit->Clear
from menu bar

4.7. Undo and Redo

If you make a mistake whether it is issuing wrong command or deleting some text by

accident, you can probably undo it with the word’s undo ! ' command. Word cannot

undo opening, saving, or printing.

- On the Standard toolbar, click the arrow next to Undo. “?° OR Edit=>Undo.

- Click the action you want to undo. If you don't see the action, scroll through the list.
When you undo an action, you also undo all actions above it in the list.
Notes
e You can undo the very last action you took by just clicking Undo on the
Standard toolbar.
o If you later decide you didn't want to undo an action, click Redo on the Standard
toolbar OR Edit->Redo
4.9. Move (Cut) or copy text and graphics
e To copy text and graphics
(G Select the text and graphics
CG  Click Edit menu } OR/| Click Copy i button on Standard toolbar

G Click copy

e To cut(move) text and graphics’
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G Select the text and graphics
G Click Edit menu OR Click Cut - button on Standard
G Click cut } toolbar

e To paste the copied and cut text and graphics

G Click where to paste (place) the copied/cut text.

G Click Edit menu _
G Click Paste OR | Click Paste 4 button on Standard

toolbar

With cut, copy and paste you can move or copy text with in a document, between
documents, between different applications. Cut, copy and paste are easy to use if you
remember the following concepts:
- You must select text before issuing a cut or copy command
- You must position the insertion point at the desired location before issuing the
paste command other wise, you will paste at the wrong location.
e The cut command removes selected text from its original location and places
it in the office clipboard.
e The copy command places selected text in the office clipboard, but it leaves
a copy of the text in the original location.
e The paste command pastes the most recently cut or copied text into the
document at the insertion point location.
Office clipboard: lets you collect items from one application or document and paste
them into any other document. The office clip board can hold up to 24 items. It can be
displayed in the task pane with the Edit — office clip board command. Once the office

clipboard is displayed, you can choose an item and paste it into your document.
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4.10. Inserting Rows and Columns
It is easy to increase a table in size by adding rows or columns to the edges, or even
between existing rows or columns.
Insert rows or columns
e Move to where the new row/s (above the cursor) or column/s (to the left of the
cursor) are to be inserted.
e Select Table | Select Row (or Column) to select the row/column. Select Table |
Insert | Rows (or Columns).
e The new rows/columns are then inserted.
e To insert more than one row or column select by highlighting the required number
of rows/columns before using the Select and Insert commands.

e Alternatively, position the cursor below where the new row is to be inserted and

3
click on the Insert Rows button, = , from the Standard Toolbar. Highlight a

column and the button will change to Insert Columns.

Self check2 Written test

Directions: Answer all the questions listed below Use the Answer sheet provided in
the next page:

Write the correct answer if it is True say True ifitis False say False

1. Which command is removes selected text from its original location and places it in
the office clipboard.
A.Cut B. copy C. paste D.all
2. Which command is places selected text in the office clipboard, but it leaves a copy
of the text in the original location.
A.Cut B.copy C. paste D. A&B

3. Which command is pastes the most recently cut or copied text into the document at
the insertion point location.

A.paste B. copy C. Cut D.Delete
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BASIC METAL WORKS

Level-l

Learning Guide-56

Unit of Competence: Operate Personal Computer

Module Title: Operating Personal Computer
LG Code: IND BMW1 M16 LO4-LG-56
TTLM Code: IND BMW1 M16 TTLM 1019v1

LO4: Operate a printer
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Instruction Sheet Learning Guide #4

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:
e . Displaying data on a printed output
e . Identifying and remedying Simple printer hardware faults and printer related
errors
This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon

e Data from a personal computer is displayed on printed output media based on
instructions

e Simple printer hardware faults and printer related error messages are identified
and remedied according to manuals

Learning Instructions:

1. Read the specific objectives of this Learning Guide.

2. Follow the instructions described below.

3. Utilize properly each information sheets

4. Accomplish the given “Self-checks.

5. If you earned a satisfactory evaluation from the “Self-check” proceed to

“Operation sheet.

6. Do the “LAP test” (if you are ready).
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Information Sheet-1 | Operate printer

1. Select the default printer and check printer settings

® Printers that you can access from your computer may be directly connected to your PC
or you may have access to printers over a network. A network printer could serve many
computers so you may not be the only person sending jobs to a printer. In this case it is
particularly useful to be able to view the progress of your print jobs as they may be
sitting in a queue waiting to be printed. You can also cancel a print job after you have
sent it to the printer.
e Printer: prints information and data from the computer on to paper. Printers are
divided in to impact printers and non impact printers.
1. Impact printers: use some sort of physical contact with the paper to produce an
image. Eg. dot matrix printers, daisy wheel printers, drum printers
2. Non impact printers: forms characters and images without making direct
physical contact between printing mechanism and the paper. E.g. ink-jet printer, laser
jet printer.

1.1. Check printers you can access

If printing over a network there may be more than one printer you can access. To check

the printers that you have access to:
1 Click on Start and then select the Control Panel.

2 Double-click on Printers and Faxes to open this item.

3 In Printers and Faxes you see the names of the computer/s that you should be

able to access.
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1.2. Change the default printer

If you have access to more than one printer, then one of those printers will be the

default printer. This means it is automatically selected when you send a job to print. In

Figure 1 you can see that the default printer has a tick next to it.

To set a printer as the default printer:

1 Inthe Printers and Faxes window right-click on the name or icon of the printer.

2 Select Set as Default Printer from the menu.
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1.3. Check printing preferences for a printer
Printing preferences include options for printing such as:

e the size of the paper you are printing to

e whether the document you are printing has a horizontal (landscape) or vertical
(portrait) layout

e whether you want to print on both sides or only one side of the paper

e how many copies of the document you want to print.
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You can change these options every time you send a document to the printer but you

can also set default options so that your preferred options are the default until you

change them.

To check or change the default printing preferences for your printer:

1 In the Printers and Faxes window right-click on the name or icon of the printer.
(See Figure 2)

2 Select Printing Preferences from the menu.

& Microsoft Office Document Image Writer Printing Pr...

| Page | Advanced | About

Page size

Ad |
Width: [21em =
Height: ’m
Orientation
* Portrait

" Landscape

DK

] [ Cancel

To change the paper size you want to print on, click on the arrow next to the box under

Page size. Select a different paper size from the popup menu.
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4 To change the orientation of your document page click in the button next to either

Portrait or Landscape.

5 Click OK to save any changes or Cancel to keep the same settings.

The preferences box for a printer will have different options depending on the model of
the printer, but the basic options shown in Figure 3 should be available for all printers.

You can select more printing preferences in a program’s Print box at the time of

printing.
1.4. Check printers and faxes

Now we’'ll look at how to check the settings for the printers that are connected to your

computer.

1 Openthe Control Panel.

2 Double-click the Printers and Faxes icon.

Figure 8 below shows the printers that are available. Yours will probably list different

printers.

Figure 8: Printers and Faxes options (in Windows XP)

3 Click on a printer to see the corresponding list of Printer Tasks listed to the left. To

perform any of these tasks, click on the task name in the list.

4 Right-click on the printer icon to see a drop-down menu with additional options.

(See Figure 9 below. Note you may have different printer names on your computer.

1.5. Print documents

You can send a document to the printer from the desktop or from within the application

program that created the document.
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Print one or more documents from the desktop
To print one or more documents from the desktop:

1 Open a folder that contains one or more documents.
2 Click on the name of the file you want to print.

3 To print more than one file, hold down the Control (Ctrl) Key on your keyboard and

keep clicking on files to add them to the selection.

4 When all the files are selected, right-click on one of the selected files. Select Print

from the menu.
All the files you selected will be sent to the printer.
Print a web page

To practise printing a document from within an application program, try printing a page
from a website. Your computer needs to be connected to the Internet and have a web

browser such as Internet Explorer.

1 Double-click on the Internet Explorer icon on the desktop to open the program. (If
your web browser is not on the desktop you may need to open the program from

Start then the All Programs menu.)

When the browser program is open you will see the Internet Explorer menus at the

top of the window.

Page 49 of 62 Federal TVET Agency | Tvet Program title : Basic Metal Work Version -1
Author/Copyright Level 1 October 2019




| File Edit View

MNew
Open...

Edit with Microsoft Office \Word

Save As...

Page Setup...

Print.., Ctrl+-P

Print Preview...

Send

Properties
Waork Offline
Close

Import and Export... I

Favorites Tools Help

>
Ctrl+O

2 Click on the File menu then select Print from this menu

3. The Print box allows you to change the printer and change the printing preferences

for the job. (Note that any changes here do not permanently override the default

settings.)
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PN OTCLILS on otfprint

|55, OTCLI3S on otfprint

|
LS

[

Status:  Ready
Location: A3 -CLI
Comment: 44, Duplex

Page Range

® al

[] Print to file

—_—
-~
v

MNumber of copies: ‘j1

(O Pages: 1

page range. For example, 5-12

~Jiale 3
Enter either a single page number or a single @ @

[ Print ][ Cancel ]

When you have made any changes to the print options click on Print to send the page

to the printer or click on Cancel if you don’t want to print the page.

You can print a document from within any application program in the same way. That is:

1 Open the document you want to print (Double-click on the filename if it is not

already open.)

2 Click on the File menu then select Print.

3 Inthe Print box check the printing preferences for your job.

4 Click on Print.
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1.6. View the progress of print jobs

If a document is taking a long time to print or the printer is busy with other people’s print
jobs, you can check all the jobs that have been sent to a printer and see where your job

is in the queue.
From the queue you can also delete a print job if you decide you want to cancel it.
To view the progress of a print job:

1 Open Printers and Faxes in the Control Panel.
2 Double-click the printer icon to open the print monitor where you can see the jobs

currently in the queue for that printer.

Shortcuts to the print monitor

Note: if you are not quick enough the document may start to print before you get a
chance to delete it. So you may like to use a shortcut to access the print monitor

quickly.

There may be a shortcut to the print monitor on the Task Bar of your desktop.

Otherwise, you can create a shortcut to a print monitor:

1 Open Printers and Faxes in the Control Panel.

2 Click on the printer icon you want to access. Hold down the mouse button and drag

the icon to the desktop.

3 A shortcut to the print monitor is now on the desktop.
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Shortcukt Eo
Microsofkt
OFFice
Document
Image YWriter

You can double-click this icon anytime to check the print jobs sent to this printer and to

delete the jobs you have sent.

1.Which Printing preferences options for printing from the listed blow

A. the size of the paper you are printing to

B a document you are printing has a horizontal (landscape) or (portrait) layout
C. you want to print on both sides or only one side of the paper

D. all

2 . to print one or more documents which steps are wrong ?
A. Open a folder that contains one or more documents
B. Click on the name of the file you want to print.
C. To print more than one file, hold down the Control (Ctrl) Key on your

D. None
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3.to open the program Internet Explorer icon on the desktop .

A Double-clickon. B Delete The Program .C. A&B D.noe

BASIC METAL WORKS

L evel-|

Learning Guide-57

Unit of Competence: Operate Personal Computer

Module Title: Operating Personal Computer
LG Code: IND BMW1 M16 LO5-LG-57
TTLM Code: IND BMW1 M16 TTLM 1019v1

LO5: Apply ergonomic principles for safe operation
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Instruction Sheet Learning Guide #5

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

5.1Explaining ergonomic principles

. Explaining Ergonomic requirement

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon

e Ergonomic principles are explained in terms of user physical well-being

e Ergonomic requirements are explained in terms of environment

Learning Instructions:

1. Read the specific objectives of this Learning Guide.

2. Follow the instructions described below.

3. Utilize properly each information sheets

4. Accomplish the given “Self-checks.

5. If you earned a satisfactory evaluation from the “Self-check” proceed to

“Operation sheet.
6. Do the “LAP test” (if you are ready).

Information Sheet

Ergonomic principles in terms of user physical well-being

1. Ergonomic principles

One branch of ergonomics deals with designing furniture that avoids causing backaches

and muscle cramps. In the computer industry, ergonomics plays an important role in the

design of monitors and keyboards. Ergonomic studies suggest preventive measures
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you can take to protect your health as you work with

computers. Another term for ergonomics is human engineering.

» Ergonomically designed keyboards- Split angled keyboards are specifically designed

to reduce the risk of injuries.

Ergonomically designed keyboard

Healthy workspace- Keep the paper copy of your work close to the height as your

screen. Position your monitor and light to minimize glare. The screen should be 3-4

times brighter than the room.

Sit at arm’s length from your monitor and about 15° to 30° below line of sight to
minimize radiation risks.

Flexible work environment - As far as possible work with an adjustable chair, an
adjustable table, and adjustable monitor and a removable keyboard. Change
your work position frequently. Re-read element 1 for guidelines on correct
posture.

Rest your eyes - Look away from the screen periodically and focus on a far-way
object or scene. You may blink frequently and take a 15- minute break from the
monitor every two hours or a smaller one every 30 minutes.

Stretch - Use the rest break to do some simple stretches to loosen tight muscles.
Pay attention to your body signals - If you feel uncomfortable take a break. Do
not ignore the message your body is sending.

The diagram below illustrates an ergonomic work centre
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Eves
Lewel with top
153 of =creen.
'] G- 2} ey

Head

Head back, i

chin tucked, | P
Ears, shoulder, 3

hips aligned.

MNeck

Uze headphones.
Do not cradle
phone betvwween
head and
shoulder!

Elbows

At sides - slightly
more than 90
degres bend.

Chair

Fully adjustable with
lumbar support in
=mall of the back.

Adjacent to and at
zame height as
monitor.

Keyboard

Same height as elbow
with wrist=s =lightly bent.
Eeystroke gentlhy!

Mouse

Adjacent to and
at =ame height
as keyboard.

Chair Height

Hip=s =slightly more than 90

degress, feet flat on the floor

Take breaks
every

30 minutes!

Directions: Answer all the questions listed below Use the Answer sheet provided in

the next page:

PART | Write the correct answer if itis True say True ifitis False

say False

1.Ergonomics is the method of minimizing risk of injury illness and property damage

2. Adjust the seat tilt so that you are comfortable where you are working on keyboard.

3.Place the keyboard in a position that allows the forearms not close to the

horizontal and the wrists to be straight.
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Lap test 1

Change display settings

Name:

Date:

Time started:

3. Instructions:

From the Control Panel, make the following changes to your Display settings.

Desktop
Change the desktop pattern to “Ripple”
Screen saver

Time finished:

You are required to perform the following individually with the
presence of your teacher.

Task 1: Change display settings

Change the screen saver setting to “Marquee”.
Select the slowest speed

Text style (Settings)

Change the Font to “Courier”.
Set the font size to 48
Set the font color to Aqua

Date and time

Check the date and time are set correctly.

e Your teacher will evaluate your output either satisfactory or unsatisfactory. If
unsatisfactory, your teacher shall advice you on additional work. But if
satisfactory, you can proceed to the next topic.
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Lap test 2.

Start up a computer

4, Instructions: You are required to perform the following individually with the

presence of your teacher.
e Start up a computer

5. Follow these steps to practice starting up a computer.
steps as you do them.

You may like to tick off the

Steps Practice | Practice
1 2
1 Check peripheral device connections. O O
2 Turn on power at the power outlet. O O
3 If the monitor has a separate switch, turn it on. O O
4 Switch on the printer. O O
5 Check to see if there is a floppy disk in the floppy disk drive | O O
if your computer has one. Eject the disk to ensure the
computer starts from the hard drive.
6 Switch on the system unit. O O
If using a desktop PC the power switch is usually a button
on the front or side of the system unit. If using a laptop the
power switch is usually at the top of the keyboard.
7 The computer will perform a start-up routine. O O
When the start-up routine has completed then the
operating system will start.
Page 59 of 62 Federal TVET Agency | Tvet Program title : Basic Metal Work Version -1
Author/Copyright Level 1 October 2019




Operation Sheet 3

Views Shutdown a computer

6. Follow these steps to practice shutting down a computer. You may like to

tick off the steps as you do them.

Steps Practice 1 Practice 2
1 Close all files (remember to save your latest | O O
work if necessary).
2 Close all software programs. O O
3 Remove floppy disks or other storage media | O O
from drives if necessary.
4  Click on Start on the taskbar. O O
5 Select Turn Off computer from the Start | O O
menu.
6 Check that Turn off is selected. O O
7 Click on OK to confirm. Your computer may | O O
automatically turn the power off but if not you
will get a message like ‘It is now safe to turn
off your computer.’
8 Switch off the computer and the power outlet. | OO O
Name: Date:

Time started:

Time finished:

7. Follow these steps to practice shutting down a computer. You may like to tick off

the steps as you do them.
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Operation Sheet 4 Create and name directories and subdirectories

Name:

Date:

Time started:

Time finished:

8. Instructions: You are required to perform the following individually with the

presence of your teacher.

Task 1: Create and name directories and subdirectories

Step 1

Create the following three directories in a folder called ‘My

Documents’:
1. Customers
2. Staff
3. Warehouse

Create the following three sub-directories within the Staff directory:

Step 2
Create the following four sub-directories within the Customers
directory:
1. CD Basement
2. Gig Shop
3. MP3togo
4. Music Beat
Step 3
1. Overtime
2. Rosters

3. Timesheets

Step 4

Create one sub-directory within the Warehouse directory:

1. Utilities

e Your teacher will evaluate your output either satisfactory or unsatisfactory. If
unsatisfactory, your teacher shall advice you on additional work. But if
satisfactory, you can proceed to the next topic.
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